
f;dr;=re yd ikaksfõok 

;dlaIKh

8 fYa%‚h

jev fmd;

wOHdmk m%ldYk fomd¾;fïka;=j



ii

 
 
m<uqjk uqøKh     -   2018
fojk uqøKh 	     -  2019

ish¨ ysñlï weúß‚

 
ISBN 978-955-25-0296-5

wOHdmk m%ldYk fomd¾;fïka;=j úiska

wxl 343" fld<U mdr" jeyer" l=reKE., ork ia:dkfhys msysá

pïmsld m%skag¾ia wdh;kfha uqøKh lrjd m%ldYhg m;a lrk ,È'



iii

Y%S ,xld cd;sl .Sh

	

	      Y%S ,xld ud;d

	      wm YS% ,xld" kfuda kfuda kfuda kfuda ud;d

	      iqkaor isßnßkS" iq/¢ w;sfidanudk ,xld

	      OdkH Okh fkl u,a m,;=re msß ch N+ñh ruHd

	      wmyg iem isß fi; iokd Ôjkfha ud;d

	      ms<s.kq uek wm Nla;s mQcd

	      kfuda kfuda ud;d

	      wm YS% ,xld" kfuda kfuda kfuda kfuda ud;d

	      Tn fõ wm úoHd  

	      Tn u h wm i;Hd

	      Tn fõ wm Yla;s  

	      wm yo ;=< Nla;s

	      Tn wm wdf,dafla  

	      wmf.a wkqm%dfKa

	      Tn wm Ôjk fõ  

	      wm uqla;sh Tn fõ

	      kj Ôjk foñfka ks;sk wm mqnqÿ lrka ud;d

	      {dk ù¾h jvjñk /f.k hkq uek ch N+ñ lrd

	      tl ujlf. ore le, neúkd

	      huq huq ù fkdmud

	      fm%au jvd ieu fNao ÿ/r od kfuda kfuda ud;d

	      wm YS% ,xld" kfuda kfuda kfuda kfuda ud;d



iv

wms fjuq tl ujlf. orefjda

tl ksjfiys fjfikd

tl mdge;s tl reêrh fõ

wm lh ;=< ÿjkd

tneúks wms fjuq fidhqre fidhqßfhda

tl f,i tys jefvkd

Ôj;a jk wm fuu ksjfia

fid¢k isáh hq;= fõ

ieug u fu;a lreKd .=fKkS

fj<S iu.s oñkS

rka ñKs uq;= fkd j th u h iem;d

lsis l, fkdu Èrkd

wdkkao iurfldaka



v

.re wOHdmk wud;H;=udf.a m‚jqvh

	 f.ù .sh oYl follg wdikak ld,h f,dal b;sydih ;=< iqúfYaIS jQ  
;dlaI‚l fjkialï /ila isÿjQ ld,hls' f;dr;=re ;dlaIKh" ikaksfõokh m%uqL 
lr.;a  fiiq lafIa;%j,  YS>% ÈhqKqj;a iuÕ j;auka isiq ore oeßhka yuqfõ kj 
wNsfhda. /ila ks¾udKh ù ;sfí' wo iudcfha mj;sk /lshdj, iajNdjh kqÿre 
wkd.;fha § iqúfYaIS fjkialï /ilg ,la jkq we;' tjka jgmsgdjla ;=< kj 
;dlaI‚l oekqu iy nqoaêh flakaø lr.;a iudchl fjkia wdldrfha /lshd wjia:d o 
,laI .Kkska ks¾udKh jkq we;' ta wkd.; wNsfhda. ch.ekSu fjkqfjka" Tn iún, 
.ekaùu wOHdmk wud;Hjrhd f,i uf.a;a" wm rcfha;a m%uqL wruqKhs' 

	 ksoyia wOHdmkfha udyeÕs m%;s,dNhla f,i fkdñf,a Tn w;g m;a jk fuu 
fmd;  ukdj mßYS,kh lsÍu;a" bka wjYH oekqu Wlyd .ekSu;a Tfí taldhk wruqK 
úh hq;= h'  tfuka u Tfí ujqmshka we;=¿ jeäysáhkaf.a Y%ufha iy lemlsÍfï 
m%;sM,hla f,i rch úiska fkdñf,a mdi,a fm<fmd;a Tn w;g m;a lrkq ,nk nj 
o Tn jgyd .; hq;= h'

	 f,dalh fõ.fhka fjkia jk jgmsgdjl" kj m%jK;dj,g  .e<fmk whqßka 
kj úIh ud,d ilia lsÍug;a" wOHdmk moaO;sh ;=<  ;SrKd;aul fjkialï isÿ lsÍu 
i|yd;a rchla f,i wm lghq;= lrkafka rgl wkd.;h wOHdmkh u;ska isÿ jk 
nj wm fyd¢ka u wjfndaO lrf.k isák neúks' ksoyia wOHdmkfha Wmßu m%;sM, 
N=la;s ú¢ñka" rgg muKla fkdj f,djg u jevodhS Y%S ,dxlsl mqrjeishl= f,i keÕS 
isákakg Tn o wÈgka lr.; hq;=  jkafka tneúks' ta i|yd fï fmd; mßYS,kh 
lsÍfuka Tn ,nk oekqu o bjy,a jkq we;s nj uf.a úYajdihhs'
 
	 rch Tfí wOHdmkh fjkqfjka úhoï lrk w;súYd, OkialkaOhg jákdlula 
tla lsÍu o Tfí hq;=lula jk w;r" mdi,a wOHdmkh yryd Tn ,nd .kakd oekqu yd 
l=i,;d Tfí wkd.;h  ;SrKh lrk nj o Tn fyd¢ka wjfndaO lr .; hq;= h' Tn 
iudcfha l=uk ;rd;srul isáh o ish¨ ndOd ì| ouñka iudcfha by< u ia;rhlg 
.uka lsÍfï yelshdj  wOHdmkh yryd Tng ysñ jk nj o Tn fyd¢ka wjOdrKh 
lr .; hq;= h'

	 tneúka ksoyia wOHdmkfha Wmßu m%;sM, ,nd" f.!rjkSh mqrjeishl=  f,i 
fyg f,dj Èkkakg;a foaY foaYdka;rj, mjd Y%S ,dxflah kduh nn<jkakg;a Tng 
yels fõjdæ hs wOHdmk wud;Hjrhd f,i uu Y=N m%d¾:kh lrñ' 

 
wls, úrdÊ ldßhjiï
wOHdmk wud;H

—	w¨;a fjñka" fjkia fjñka" ksj/È	 oekqfuka 
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1fkdñf,a fnod yeÍu msKsihs

l%shdldrlu 1'1

mo ,ehsia;=fõ we;s mo Ndú; lr ysia;eka mqrjkak' 

mo ,ehsia;=j 

oaúuh" 2" mdoh" 10" oYuh

a)	 ixfla; oyhla Ndú; flfrk ixLHd moaO;sh '''''''''''''''''''''''''''''''''''' 

ixLHd moaO;sh fõ' 

b)	 1001
10
 ixLHdfõ mdoh '''''''''''''''''''''''''''''''''''' fõ' 

c)	 ixfla; ''''''''''''''''''''''''''''''''' la Ndú; flfrk ixLHd moaO;sh  

'''''''''''''''''''''''''''''''''''' ixLHd moaO;sh fõ' 

d)	 ixLHd moaO;shl we;s ixfla; (symbols) m%udKh tu ixLHd moaO;sfha   

''''''''''''''''''''''''''''''''''' fõ' 

l%shdldrlu 1'2 

my; oelafjk oYuh ixLHd úysÿjd ,shkak' 

a)  52810		  b)  18610		  c)  30810	

l%shdldrlu 1'3

my; oelafjk oYuh ixLHd oaúuh ixLHd njg mßj¾;kh lrkak'

a)  2810		   b)  4710	          c)  10110	                              d)  12810	                    

e)  17310	

ixLHd moaO;s1



2 fkdñf,a fnod yeÍu msKsihs

l%shdldrlu 1'4

my; oelafjk oaúuh ixLHd oYuh ixLHd njg mßj¾;kh lrkak'

a)  100102	           b)  110112	       c)  10110112    	         d)  1111112	

e)  100000002
	

l%shdldrlu 1'5

my; rEmh weiqßka wid we;s m%Yakj,g ms<s;=re imhkak'

ICT

0110110011001

01101100110

0110110
0110

01

ICT

YsIHhd úiska ICT hk jpkh ghsma lrk úg o;a; yqjudre jk wkqms<sfj< 

oelafjk mßÈ rEmfha B;, u; we;s rjqu u; wxl ,shkak'

mshjr wxlh 		  isÿ jk l%shdj 

	

    

2

3

1 	 	 ICT jpkh ghsma lrk úg o;a; oaúuh wdldrfhka  

			   moaO;s tallh fj; hdu

		      					       			 

			   mß.Kl u;lh ;=< ;ekam;aj we;s oaúuh o;a;  

			   uqøK hka;%h fj; f.dia ICT jpkh uqøKh ùu

 

			   mß.Kl u;lh ;=< ;ekam;a jQ oaúuh o;a; ixo¾Ylh 

			   fj; f.dia ICT jpkh Èiaùu
  



3fkdñf,a fnod yeÍu msKsihs

	 fuu mdvfuys ish¨ l%shdldrlï i`oyd Ndú; lr we;af;a Windows 10  
fufyhqï moaO;shhs'

l%shdldrlu 2'1 

Tfí mß.Klfha fõ,d l,dmh" Èkh" fõ,dj" uqo,a tallh iy ixLHd 

wdlD;s ksjerÈj ilia lruq' 

²² fuu ish¨ isgqjï tl u ixjdo fldgqjl § (dialog box) isÿ lsÍug 

fufyhqï moaO;sh bv i,id we;' 

²² ta wkqj fuu isgqjï ish,a, lsÍug my; oelafjk mshjr wkq.ukh 

lrkak'

mshjr 01 - 	  whslkh u; la,sla lr tys Windows System hgf;a we;s  

		  Control Panel u; la,sla lrkak'

2

3

1

fufyhqï moaO;sh Ndú;fhka mß.Klhla 
úkHdi lsÍu iy isgqjï lsÍu 2



4 fkdñf,a fnod yeÍu msKsihs

mshjr 02 - 	 Control Panel ys Date and Time u; la,sla lrkak'

4

mshjr 03 - 	 Tng ,efnk ixjdo fldgqfjys Change Date and Time fnd;a;u u;  

		  la,sla lrkak' túg ,efnk ixjdo fldgqfjys ksjerÈ Èkh iy 

		  fj,dj ilia lr OK fnd;a;u u; la,sla lrkak' 

5 6

8

7

mshjr 04 - 	 Date and Time ixjdo fldgqfjys Change Time Zone ̂ fõ,d l,dmh& 

		  fnd;a;u u; la,sla lrkak' túg ,efnk ixjdo fldgqfjys fõ,d 

		  l,dmh f,i Sri Jayawardhenepura f;dard OK fnd;a;u u; la,sla 

		  lrkak'

9

10

11



5fkdñf,a fnod yeÍu msKsihs

mshjr 05 - 	 Tfí mß.Klfha Èkh iy fõ,dj oelafjk wdlD;sh ilia lruq' 

		  Control Panel ys Region u; la,sla lrkak'

12

mshjr 06 -	 ixjdo fldgqfõ Formats u; la,sla lr tys my;ska oelafjk  

		  Èkh  iy fõ,dj i`oyd we;s wdlD;s w;ßka Tn leu;s wdldr f;dard  

		  f.k Apply fnd;a;u u; la,sla lrkak' 

13

14

15

mshjr 07 - 	 Tfí mß.Klfha ixLHd olajk wdlD;sh" ñkqï tall iy uqo,a  

		  tall f;dard .ksuq' by; 'Region' ixjdo fldgqfõ u we;s Additional  
		  settings fnd;a;u u; la,sla lrkak' túg ,efnk ixjdo fldgqfõ  

		  Numbers u; la,sla lr b,lalï wdlD;sh f,i wxl ms<sfj, wkqj  

		  ;=fkys ldKav f,i b,lalï ,shk wdlD;sh o ñkqï tall metric 
		  f,i o f;dard .kak'



6 fkdñf,a fnod yeÍu msKsihs

16

18

19

20

17

mshjr 8 - 	 wfma rgg wod< uqo,a tallh ilia lr .ksuq' ta i`oyd Currency u; 

		  la,sla lr $ i,l=K uld ta fjkqjg tys Rs f,i ghsma lr OK   
		  fnd;a;u u; la,sla lrkak'

21

22

23



7fkdñf,a fnod yeÍu msKsihs

l%shdldrlu 2'2 

mß.Kl f.dkq .=Kdx. úkHdih 

fuu ld¾hh lsÍu msKsi" Tn mßmd,l .sKqula (Administrator Account) 
iu. mß.Kl cd,hg mQrKh (Log in) úh hq;= h' tneúka fuu l%shdldrlï 

.=re;=ud fyda .=re;=ñh fyda úiska Tng wdo¾Ykh lr fmkajkq we;' Tng 

.=Kdx. msßlaiSug fyda .=Kdx. fjkia lsÍug fyda wjYH f.dkqj f;dard 

.kak' my; oelafjk mshjr wkq.ukh lrkak'

mshjr 01 - 	 Tn f;dard.;a f.dkqj u; Right la,sla lr ,efnk fukqfõ 

		  Properties u; la,sla lrkak' túg ,efnk ixjdo fldgqfjys"  

		  f.dkqfõ j¾.h (Type of file)" f.dkqfõ msysàu (Location) iy 

		  f.dkqfjys úYd,;ajh (Size) hk .=Kdx. Tng meyeÈ,sj n,d.; 

		  yels h' 

1

2

3



8 fkdñf,a fnod yeÍu msKsihs

mshjr 2 -	 Tn f;dard .;a f.dkqj iqrlaIs; lsÍu i`oyd úfYaI .=Kdx. folla  

		  fuys we;=<;aj we;' tajd kï f.dkqj lsisfjl=g;a o¾Ykh fkdù 

		  ;nd .ekSu (Hidden) iy wka whg lsisÿ ixialrKhla fkdlr  

		  lshùug muKla (Read only) wjir ,nd §u h' fuu .=Kdx. il%sh  

		  lsÍu" ,eî we;s ixjdo fldgqfõ Attributes bÈßfhka we;s i,l=Kq 

		  fldgq ,l=Kq lsÍu u.ska isÿ l< yels h' fuu .=Kdx. tlla fyda  

		  fol u fyda tl jr il%sh l< yels h' ta i`oyd my; i`oyka  

		  mshjr wjYH mßÈ wkq.ukh lrkak' i,l=Kq lsÍu wjidkfha  

		  Apply fnd;a;u u; la,sla lrkak'

l%shdldrlu 2'3 

²² Tn mß.Klfhys iq/ls f.dkqjla miqj kej; wjYH jQ wjia:djl § th 

iq/lS we;s ia:dkh Tng wu;l jqjfyd;a tu f.dkqfõ ku" f.dkq j¾.h" 

iq/ls Èkh jeks oE wkqj tu f.dkqj fidhd .ekSug Tng yelshdj we;' 

f.dkqfõ m%j¾.h (Type) wkqj f.dkqjla fidhk wdldrh úuid n,uq' 

f.dkq m%j¾.h okafka kï mß.Klfha we;s tu m%j¾.fha ish¨ f.dkq 

,ehsia;=jla ,nd .; yels h' f.dkq kduhl f.dkq m%j¾.h olajkafka 

f.dkq kdufha È.=j (Extension) u.sks' tneúka tu È.=j Ndú;fhka tu 

m%j¾.fha ish¨ f.dkq fidhd .kafka flfia oehs n,uq'

²² WodyrKhla f,i ''docx'' È.=j iys; f.dkq ish,a, fidhuq' my; 

oelafjk mshjr wkq.ukh lrkak' 

4

5

6

7



9fkdñf,a fnod yeÍu msKsihs

mshjr 1 -	 uq,ska u f.dkq .fõIKh lsÍu i`oyd File Explorer fj; huq' ta 

		  i`oyd  u; right la,sla lrkak' túg ,efnk fukqfõ File 
		  Explorer u; la,sla lrkak' 

2

1

mshjr 02 -	 bkamiq f.dkq fiúh hq;= ia:dkh f,i This PC u; la,sla lrkak'  

		  File Explorer ;srfha by< ol=Kq fl<jf¾ we;s ''Search quick  
		  access'' f,i i`oyka ia:dkfha Tn fidhk f.dkq È.=j docx f,i  

		  ghsma lrkak' Tfí fijqug wod<j mß.Klfha we;s docx È.=j  

		  iys; ish¨ u f.dkq Tng Èiajkq we;' tu ,ehsia;=fjka Tng wjYH 

	 	 f.dkqj fidhd .kak'

4

   

5

igyk - Windows fufyhqï moaO;sfha hdj;ald,Sk lsÍï iu. fuu 

mßÉfþofha oelafjk ;sr msgm;a (Screen captures) fjkia úh yel'

3



10 fkdñf,a fnod yeÍu msKsihs

my; oelafjk fhÿï w;ßka jvd;a .e<fmk fhÿu f;dard ysia;eka mqrjkak' 

mß.Kl" B;¾fkÜ flfjksh" h;=re mqjrej" PS 2" HDMI" Odjl uDÿldx." 

Uninstall, VGA" úÿ,s iemhqu úikaê" Restart" oDVdx. fodaI" m%Odk wdphkfha" 

USB" install" uDÿldx. fodaI" RJ45" fhÿï uDÿldx." uQislh

1'	 ''''''''''''''''''''''''''''''''''' iy ''''''''''''''''''''''''''''''''''' mß.Kl iu. lghq;= lrk úg 

fndfyda úg uqyqK§ug isÿjk .eg¨ fõ'

2'	 '''''''''''''''''''''''''''''' iy '''''''''''''''''''''''''''' l%shd;aul fkdùu oDVdx. fodaIhls' 

3'	 mß.Klhg iïnkaO lr we;s ish¨ /yeka mÍlaId lsÍu isÿ l< hq;af;a  

''''''''''''''''''''''''''''''''''' lsÍfuka miqj h'

4'	 h;=remqjrej iy uQislh i`oyd ''''''''''''''''''''''''''''''''''' flfjks (Port) fyda  

''''''''''''''''''''''''''''''''''' flfjks Ndú; l< yels h' 

5'	 RJ45 iïnkaOlh iys; /yek iïnkaO lrkq ,nkafka ''''''''''''''''''''''''''''''''''' fha 

''''''''''''''''''''''''''''''''''' g h'

6'	 mß.Klhlg rEmjdyskshla iïnkaO lsÍfï § Ndú; lrkq ,nkafka  

''''''''''''''''''''''''''''''''''' /yeka h' 

7'	 mß.Kl Ndú;fha § we;s jk fndfyda .eg¨j,g we;s m<uq úi`ÿu jkafka 

mß.Klh ''''''''''''''''''''''''''''''''''' lsÍu h'

8'	 mß.Klhg iïnkaO lr we;s iuyr oDVdx. ksishdldrj l%shd;aul fkdjkafka 

tu oDVdx.j, ''''''''''''''''''''''''''''''''''' ia:dmkh lr fkdue;s ksid h'

9'	 ''''''''''''''''''''''''''''''''''' ysia wjldYh wvq jQ úg mß.Klh ukao.dó fõ'

10'	mß.Klhl ld¾hlaIu;dj jeä lr .ekSug kï wkjYH uDÿldx. 

''''''''''''''''''''''''''''''''''' l< hq;= h'

l%shdldrlu 2'4

my; oelafjk j.=fõ uq,a ;Srefõ we;s rEmhg wod< bx.%Sis wlaIrh fojeks 

;Srefõ wod< ku iu. .,md ysia;ek bÈßfhka ,shkak'

 
A DVI flfjksh

''''''''''''''''

B SD m;a flfjksh ''''''''''''''''
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C HDMI flfjksh ''''''''''''''''

D eSata flfjksh ''''''''''''''''

E Parallel flfjksh ''''''''''''''''

F VGA flfjksh ''''''''''''''''

G Micro USB flfjksh ''''''''''''''''

H RJ45 B;¾fkÜ 

flfjksh
''''''''''''''''

I  HD Audio flfjkssh ''''''''''''''''

J Display flfjksh ''''''''''''''''

K PS2 flfjksh ''''''''''''''''

L USB flfjksh ''''''''''''''''
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l%shdldrlu 2'5

my; oelafjk nyqjrK m%Yak i`oyd § we;s ms<s;=re w;ßka ksjerÈ ms<s;=r 

f;dard thg háka brla w`Èkak' 

1'	 mß.Klh iu. lghq;= lrk Tng fndfyda úg uqyqK§ug isÿjk uQ,sl 

.eg¨ j¾. folla we;' tajd kï"

a. 	 uq,Huh .eg¨ iy NdIduh .eg¨ 

b.	 .Ks; .eg¨ iy oDVdx. .eg¨

c.	 uDÿldx. .eg¨ iy oDVdx. .eg¨ 

d.	 uDÿldx. .eg¨ iy NdIduh .eg¨

2'	 ir, oDVdx. fodaIhla i`oyd WodyrKhla jkafka"

a.	 fufyhqï moaO;sh wl%shùu 

b.	 uQislh l%shd;aul fkdùu  

c.	 mß.Klh wdrïN lsÍug jeä ld,hla .;ùu

d.	 m%Odk wdphkfha ysia wjldYh wvqùu

3'	 mß.Klhla cd,h yd iïnkaO fkdùug fya;= úh yelafla"

a.	 uDÿldx. fodaIhls

b.	 oDVdx. fodaIhls 

c.	 jhsri wdidokhls

d.	 by; lreKq ish,a, u h 

4'	 mß.Klhla n, .ekaúh fkdyels wjia:djl mß.Klhg úÿ,sh ,efí 

oehs mßlaId lsÍug Tng isÿ fõ' tjeks wjia:djl uq,ska u Tn l< 

hq;af;a"

a.	 mß.Klhg úÿ,sh imhk /yek fyd`Èka iú lsÍu h 

b.	 UPS tlg úÿ,sh imhk /yek mÍlaId lsÍu h

c.	 m%Odk iemhqfuka úÿ,sh úikaê lsÍu h

d.	 mß.Klh n,.ekaùfï fnd;a;u tîu h

5'	 my; oelafjk Wmdx. w;=ßka mß.Klfha USB flfjksh Ndú; lr 

mß.Klhg iïnkaO l< fkdyels Wmdx.hla jkafka"

a.	 uqølh 

b.	 ixo¾Ylh 

c.	 iqmÍlaIlh 

d.	 h;=re mqjrej
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6'	 mß.Klhg rEmjdyskshla (TV) iïnkaO lrkafka kï jvd;a iqÿiq 

flfjksh jkafka"

a.	 USB flfjkshhs 

b.	 DVI flfjkshhs 

c.	 eSata flfjkshhs 

d.	 HDMI flfjkshhs

7'	 mß.Klhg ikao¾Ylhla iïnkaO l< fkdyels flfjksh jkafka"

a.	 DVI flfjksh 

b.	 USB  flfjksh 

c.	 VGA flfjksh

d.	 HDMI flfjksh

8'	 Tfí mß.Klfha me;=reïm;a fhÿï uDÿldx. újD; lsÍug fkdyels h' 

fuhg fya;= úh yelafla" 

a.	 jhsri l%shdldrluls'

b.	 me;=reïm;a fhÿï uDÿldx.h krlaùu (corrupt) h 

c.	 fkdñf,aa w;ayod ne,Sug § ;snQ ld,h wjikaùu h

d.	 by; i`oyka l=uk fyda fya;=jla ksid úh yels h

9'	 eSata flfjksh fhdod .kq ,nkafka my; oelafjk l=uk Wmdx.h 

iïnkaO lsÍug o@

a.	 ixo¾Ylh 

b.	 uQislh fyda h;=re mqjrej 

c.	 by< ;;a;ajfha (HD) kdol 

d.	 ndysr wdphk (storage) Wmdx. 

10'	mß.Klhg iïnkaO lrkq ,nk fndfyda Wmdx. tajdg wdfõKsl jQ 

úúO flfjks yryd iïnkaO lsÍu uq,a ld,fha isÿ jqj o ;dlaIKfha 

ÈhqKqj;a iu. Wmdx. fndfyduhla iïnkaO l< yels fmdÿ flfjkshla 

kQ;k mß.Klj, olakg we;' tu flfjksh jkafka"

a.	 HDMI h
b.	 eSata h
c.	 DVI h
d.	 USB h
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	 joka ieliSfï uDÿldx.fha Ñ;%l mßYS,l w;=re uqyqKf;ys (Graphic User 
Interface) fuj,ï lsysmhla fufia y`ÿkd .ksuq'

tfl,a, lsÍfï iy ia:dk.; lsÍfï fuj,ï

Alignment and Positioning Tools

h;=re,shkh i`oyd l¾irh

Cursor point

wl=re yeviõ lsÍfï fuj,ï

Text Formatting Tools

joka ieliSu3



15fkdñf,a fnod yeÍu msKsihs

l%shdldrlu 3'1 

²² my;ska olajd we;s f,aLkh fyd`Èka wOHhkh lr th yeviõ lsÍu 
(Formatting) i`oyd fhdod f.k we;s fuj,ï fudkjd oehs my;ska 

,shkak' 

AN apple

An apple can taste very nice,
Try a bite or slice,
If it’s red or if it’s Green,
It will taste good if it’s clean.

My grandma says “ An apple a day,
Always keeps the doctor  away”

2

3

4
1

6

5

	 1' ''''''''''''''''''''''''''''''''''''''		     4' ''''''''''''''''''''''''''''''''''''''

	 2' ''''''''''''''''''''''''''''''''''''''		     5' ''''''''''''''''''''''''''''''''''''''

	 3' ''''''''''''''''''''''''''''''''''''''		     6' ''''''''''''''''''''''''''''''''''''''

fþo" jdlH fyda jpk f;dard .kakd wdldr :-  

l%shdldrlu 3'2

by;ska olajd we;s f,aLkh ks¾udKh lrk wdldrh bf.k .ksuq'

mshjr 1 - 	 Tnf.a mß.Klfha we;s joka ieliSfï (Word processing 
		  software) uDÿldx.h jk Microsoft Office Word 2013 újD;  

		  lr .kak' 

kj f,aLkhla i`oyd kj msgqjla ,nd .kakd wdldrh 

File → New → Blank Document f;dard .kak' 

mshjr 2 - 	 h;=re mqjrej (keyboard) u.ska l¾irh we;s ia:dkfha isg 

		  wdrïN lr my; olajd we;s f,aLkh h;=re,shkh lrkak'
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ie'hq' - jdlHhla wjidkfha § h;=re mqjrefõ Enter 
h;=r u.ska B<`. fma<shg hkak' ^,ehsia;=" ud;Dld 

iy ;ks jdlH i`oyd&

 

tfy;a fþohla h;=re,shkh lsÍfï § fþoh wjidk jk ;=re 

tl È.g u h;=re,shkh lr wjidkfha § Enter h;=r u.ska th 

wjidk lrkak'
 

An Apple

An apple can taste very nice,
Try a bite or a slice,
If it’s red or if it’s green,
It will taste good if it’s clean.
My grandma says “An apple a day,
Always keeps the doctor away”

mshjr 3 - 	 h;=re,shkh lsÍfuka wk;=rej yeviõ lsÍu i`oyd fþoh"  

	     	 jdlHh fyda jpkh f;dard .; hq;= h' (text selection) 	

;ks wl=rla 

fyda lsysmhla 

uQislh la,sla lrf.k wl=re yryd hkak'

jpkhla uQislh tl úg fojrla jpkh u; la,sla lrkak' 

jpk lsysmhla f;dard .ekSug n,dfmdfrd;a;= jk jpk lsysmfhys 

m<uqjk jpkh u; la,sla lr wjidk jpkh f;la 

wÈkak'

jdlHhla jdlHfha m<uqjk jpkh u; la,sla lr wjidk 

jpkh f;la wÈkak'

fma<shla iqÿ meye;s ol=Kq ÈYd.; B;,hla fmfkk f;la 

fma<sfha bÈßhg uQislh f.k hkak' th ÿgq úg jrla 

la,sla lrkak' 

fþohla fþoh u; tl úg ;=ka jrla uQislh la,sla lrkak

ke;fyd;a

fþofha m<uq jpkh u; la,sla lr wjidk jpkh 

f;la weof.k hkak' 

f,aLkhla h;=re,shkfha Ctrl + A tl úg Tnkak'
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mshjr 4 - 	 f;dard .;a fþo" jdlH fyda jpk joka ieliSfï  

		  uDÿldx.fha Home genfha Font ldKavfha we;s yeviõ  

		  lsÍfï fuj,u u; la,sla lrñka yeviõ lrkak'

mshjr 5 - 	 bka miq ilia lr .;a f,aLkh ;ekam;a l< hq;= h'

f,aLkh ;ekam;a lrk wdldrh 

²² File → Save  f;dard .kak' 

²² ;ekam;a lsÍug iqÿiq ia:dkhla (saving location) Save in 
ia:dkfhka f;dard .kak' 

²² f,aLkhg iqÿiq kula File name bÈßfhka h;=re,shkh lrkak'

²² Save fnd;a;u la,sla lrkak'

l,ska ;ekam;a lrk ,o f,aLkhla fjk;a kulska ;ekam;a lrk 

wdldrh 

²² File → Save as f;dard .kak' 

²² ;ekam;a lsÍug iqÿiq ia:dkhla Save in ia:dkfhka f;dard 

.kak' 

²² f,aLkhg iqÿiq kula File name bÈßfhka h;=re,shkh 

lrkak'

²² Save fnd;a;u la,sla lrkak'

mshjr 6 - 	 ;ekam;a lsÍfuka miqj f,aLkh jid oukak'

f,aLkhla jid ouk wdldrh 

File → Close  f;dard .kak' 
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l%shdldrlu 3'3 

²² my;ska olajd we;s f,aLkh fyd`Èka wOHhkh lr th tfl,a, lsÍu 

iy ia:dk .; lsÍu (Alignment and Positioning) i`oyd fhdod f.k we;s 

fuj,ï fudkjd oehs y`ÿkdf.k my;ska ,shd olajkak'

Save Trees, Save Mother Earth

Things to do…

1. Plant a tree and get air for tree
2. If you cut a tree you cut your lives
3. The tree is your friend
4. Feel free to plant a tree
5. Trees are the roots of all living beings
6. A tree that stays, keeps flood away

√  Protect trees
√  There is no life without Green
√  Take care of trees, they will take care of you

	                      Connecting people to Green

Save trees and protect Mother Earth from 
global warming. Don’t destroy the greenery 
and don’t spoil the scenery. Save Mother 
Earth.

1

3

6}
4 }

}5

2

7

8
 	

			 1' ''''''''''''''''''''''''''''''''''''''  

	 2' ''''''''''''''''''''''''''''''''''''''	

	 3' ''''''''''''''''''''''''''''''''''''''	

	 4' ''''''''''''''''''''''''''''''''''''''		     

5' ''''''''''''''''''''''''''''''''''''''

     6' ''''''''''''''''''''''''''''''''''''''

     7' ''''''''''''''''''''''''''''''''''''''

     8' ''''''''''''''''''''''''''''''''''''''
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l%shdldrlu 3'4  

²² by;ska olajd we;s f,aLkh ks¾udKh lruq'

mshjr 1 - 	 f,aLkh ks¾udKh lsÍu i`oyd kj msgqjla ,nd .kak'

mshjr 2 -	 my; oelafjk wdldrhg f,aLkh kj msgqfjys h;=re,shkh  

		  lrkak'

mshjr 3 -	 wjYH fþo" jdlH fyda jpk f;dard .ksñka by;  

		  l%shdldrlfï oelajQ wdldrhg yeviõ lrkak'

mshjr 4 -	 bka miq ilia lrk ,o f,aLkh ;ekam;a lr th jid  

		  oukak'

Save Trees, Save Mother Earth

Save trees and protect Mother Earth from global warming. 
Don’t destroy the greenery and don’t spoil the scenery. Save 
Mother Earth.

Things to do…

Plant a tree and get air for tree
If you cut a tree you cut your lives
The tree is your friend
Feel free to plant a tree
Trees are the roots of all living beings
A tree that stays, keeps flood away
Protect trees
There is no life without Green
Take care of trees, they will take care of you

Connecting people to Green
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l%shdldrlu 3'5

²² my; § we;s f,aLkh ks¾udKh lr ;ekam;a lrkak'

Computer Software
Software are logical components of computer, which can't 
be seen and touched. Softwares are used to run the computer 
in  an efficient manner. Without software, computer is like a 
vehicle without fuel. These are four major types of software:

1.	 System Software

2.	 Application Software

3.	 Utility Software and Service Programme

System Software:

System softwares are those which are provided by 

manufacturers to the user. They are used to control the 

computer system and increase computer performance.

l%shdldrlu 3'6 

²² my;ska olajd we;s fmdaiagrh fyd`Èka wOHhkh lrkak' th ks¾udKh 

lsÍu i`oyd fhdod f.k we;s foa my;ska olajd we;'  



21fkdñf,a fnod yeÍu msKsihs

1

2

3

6

4

5

1'	 fjkia jQ wl=re j¾.hla Ndú; lr" wl=re m%udKh fjkia lr" j¾K 

.kajd ueog tfl,a, lr we;' 

2'	 mska;+rhla ueog tfl,a, lr we;'

3'	 l,d;aul wl=re fhdod we;' 

4'	 wl=re fldgq fhdod jpk h;=re,shkh lr we;' 

5'	 j¾K .ekajQ yev;,hla ;=< h;=re,shkh lr we;'

6'	 msgqjg fndavrhla fhdod f.k we;'
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by;ska olajd we;s fmdaiagrh ks¾udKh lruq'

mshjr 1 - 	 f,aLkh ks¾udKh lsÍu i`oyd kj msgqjla ,nd .kak'

SATURDAY MAY 25th 
10 am - 4 pm

At school ground

mshjr 2 -  	 uq,ska § we;s jdlH 3  

		  h;=re,shkh lrkak'

mshjr 3 - 	 tu jdlH f;dard  

		  ks¾udKhg .e<fmk 

		  fjkia wl=re j¾.hla f;dard" wl=re m%udKh o fjkia lr"  

		  j¾K .kajd" ueog tfl,a, lrkak'

f,aLkhg mska;+rhla tl;= lsÍu 

mshjr 4 - 	 mska;+rh wjYH ia:dkfha uQislh la,sla lrkak'

		  Insert → Pictures / Online Pictures f;dard .kak'

		  Pictures f;dard .;af;a kï túg ,efnk Insert Picture 
		  ljq¿fjka leu;s mska;+rhla u; click lr Insert fnd;a;u 

		  click lrkak'

mshjr 5 - 	 Tn Online Pictures f;dard 

		  .;af;a kï wjYH jk 

		  mska;+r kduh wka;¾cd, 

		  n%jqi¾ ;Srefõ h;=re,shkh  

		  lr iqÿiq mska;+rhla f;dard  

		  Insert la,sla lr ,nd .kak'

mshjr 6 -	 ,nd .;a mska;+rh wjYH  

		  m%udKhg ilia lr .ekSu'  

		  fï i`oyd mska;+rh u;  

		  la,sla lrkak'

mshjr 7 -	 mska;+rh m%udK lsÍfï  

		  ye`v,a (Resizing handle)  
		  u;g ujqih f.k hñka 

		  mska;+rfha m%udKh fjkia 		

		  lr .; yels h'

f,aLkhg l,d;aul wl=re Word Art tl;= lsÍu

mshjr 8 -	 l,d;aul wl=re wjYH jk ia:dkfha uQislh la,sla lrkak'
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mshjr 9 -	 Insert → Word Art u; la,sla  

		  lr mdg iy wl=re yevhla  

		  f;darkak'

mshjr 10 -	 bkamiq ''KIDS' FUN DAY''   
		  hkqfjka tys h;=re,shkh  

		  lrkak'

mshjr 11 -	 f,aLkh u;g ,o jpk  

	u; la,sla lrkak' fukq 

;Srfha má;af;a WordArt 
Styles j, we;s Text  
	Effects → Transform u;ska  

	ksjerÈ yevh f;dard .kak'

mshjr 12 -	 ''KIDS       FUN          DAY'' hk jpk  

		  mejrefï wdldrhg msgqfõ 

		  ueo by<ska ;nkak'

mshjr 13 - 	 ''KIDS FUN DAY'' hkakg 

		  my<ska § we;s jdlH 2  

		  h;=re,shkh lrkak'

mshjr 14 - 	 tu jdlH f;dard" ks¾udKhg .e<fmk fjkia wl=re  

		  j¾.hla f;dard" wl=re m%udKh o fjkia lr" j¾K .kajd"  

		  ueog tfl,a, lrkak'

f,aLkhg wl=re fldgq (Text Box) tl;= lsÍu  

ENTERTAINMENT
FACE PAINTING 
SIDEWALK SALE

CHALLENGES
KIDS' YOGA
DANCING

TASTY FOOD 
GAMES 
PRIZES

mshjr 15  - 	 Insert → Text Box → Draw Text Box la,sla lr wjYH  

		  m%udKhg ujqih la,sla lrñka wl=re fldgq 3 we`o .kak' 

		  tajd ;=< by; oelafjk wdldrhg h;=re,shkh lrkak'
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mshjr 16 -	 wl=re fldgqfõ fndavrh ilia lr .ekSug ta u; ujqia 

		  la,sla lrñka wl=re fldgqj f;dard .kak' fukq ;Srfha  

		  Format Shape u.ska .e<fmk yev;,h f;dard .kak'	

	

f,aLkhg yev;, tl;= lsÍu 

 

ABC Kinder School 

Badulla 
mshjr 17 -	 yev;,h wjYH jk ia:dkfha uQislh la,sla lrkak'

mshjr 18 -	 Insert → Shape la,sla lr wjYH yev;, f,aLkh u; we`o 

		  .kak'

yev;,hla ;=< wl=re fh§u i`oyd 

mshjr 19 -	 yev;,h u; uQislfha ol=Kq fnd;a;u la,sla lr  → Add 
		   Text f;dard .kak'

mshjr 20 -	 wjYH wl=re tys h;=re,shkh lrkak'

mshjr 21 -	 yev;,h f;dard fukq ;Srfha 

		  Drawing Tools → Format hgf;a we;s .e<fmk yeviùï 

		  lrkak' ^j¾K" fndav¾ wdÈh&

f,aLkhg fndavrhla tl;= lsÍu 

mshjr 22 -	 fukq ;Srfha Design → Page Borders → Art u.ska .e<fmk  

		  fndavrhla f;dard OK lrkak'

mshjr 23 -	 ks¾udKh ;ekam;a lrkak'
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l%shdldrlu 3'7 

²² Tnf.a mdif,a W;aijhla i`oyd wdrdOkd m;la ks¾udKh lrkak' 

²² Tnf.a hy¿jdf.a WmkaÈkh fjkqfjka ldâm;la ks¾udKh lrkak' 

²² ''Let's Protect the Environment'' ud;Dldj fhdodf.k fmdaiagrhla 

ks¾udKh lrkak'

l%shdldrlu 3'8 

²² j.= ks¾udKh
	

	 ;Srej,ska iy fma<sj,ska iukaú; jia;=jla j.=jla kï fõ' ;Srejla 

iy fma<shla tl;= jk ia:dkh fldaIh kï fõ' 

    

fma<sh

;Srej fldaIh 

fuu j.=fjys ;Sre 4 la o" fma<s 3 la o" fldaI 12 la o we;'

²² my; oelafjk j.=fjys we;s ;Sre" fma<s iy fldaI .Kk lSh o@

 

³³ ;Sre 	 - '''''''''''''''''''''''''''''''''''''''''

³³ fma<s 	 - '''''''''''''''''''''''''''''''''''''''''

³³ fldaI 	- '''''''''''''''''''''''''''''''''''''''''
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l%shdldrlu 3'9 

²² my; oelafjk j.=j wOHhkh lrkak' fujeks j.=jla ks¾udKh lsÍfï 

§ fhdod f.k we;s yeviùï y`ÿkd .kak'

 

1 2 3 4 5 6 7 8 9 10 11 12
1 1
2 2 4
3 3 9
4 4 16
5 5 25
6 6 36
7 7 49
8 8 64
9 9 81

10 10 100
11 11 121
12 12 144

²² fuh .=K lsÍfï j.=jls' 

²² fuys ;Sre 13 la iy fma<s 14 la we;' 

²² m<uq fma<sfhys we;s fldaI ish,a, u ;ks fldaIhla njg m;a lr we;' 

²² ud;Dldj i`oyd l,d;aul wl=re fhdod we;' 

²² ;Sre" fma<s iy fldaI j¾K .kajd we;' 

²² h;=re,shkh lrk ,o b,lalï fldaIfha uOHhg tfl,a, .kajd we;'

fujeks j.=jla ks¾udKh lruq' 
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ks¾udKh i`oyd ;Sre iy fma<s ,nd .ekSu 

mshjr 1 - 	 Insert → Table → Insert Table

mshjr 2 - 	 wjYH ;Sre iy fma<s  

		  m%udKh fuys § újD; jk  

		  ljq¿fõ igyka lr OK 
		  la,sla lrkak'

fldaI folla fyda lsysmhla ;ks 

fldaIhla njg m;a lsÍu

mshjr 3 - 	 fï i`oyd wjYH lrk  

		  fldaI m%udKh uQislh 

		  la,sla lrñka f;dard  

		  .kak'

mshjr 4 - 	 fukq ;Srfhkaa Table Tools →  Layout → Merge Cells f;dard  

		  .kak'

ud;Dldj i`oyd l,d;aul wl=re fh§u 

Amshjr 5 - 	 m<uq fma<sh ;=< uQislh la,sla lrkak'

mshjr 6 - 	 fukq ;Srfhka Insert → Word Art f;dard .kak' 

mshjr 7 - 	 Tng leu;s l,d;aul wl=re j¾.h f;dard .kak'

mshjr 8 - 	 wjYH fhÿu h;=re,shkh lrkak'

;Sre fma<s iy fldaI j¾K .ekaùu

mshjr 9 - 	 j¾K .ekaùug wjYH jk fldaIh u; la,sla lrkak'

mshjr 10 - 	 fukq ;Srfhka Home → Shading u; la,sla lr  

		  wjYH j¾Kh f;dard .kak'
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h;=re,shkh lrk ,o b,lalï fldaIfha uOHhg tfl,a, .ekaùu

mshjr 11 - 	 wjYH b,lalï fyda wl=re fldaI ;=<  

		  h;=re,shkh lrkak'

mshjr 12 - 	 uQislh la,sla lrñka iïmQ¾K j.=j  

		  f;dard .kak'

 mshjr 13 -  	 fukq ;Srfhka Table Tools → Layout  
		  → Alignment ;=<ska wjYH tfl,a, lsÍu f;dard .kak'

 mshjr 14 -	 ks¾udKh lrk ,o j.=j iys; f,aLkh ;ekam;a lr jid  

		  oukak'

l%shdldrlu 3'10 

²² Tnf.a mka;s ldurhg wjYH lrk j.= ks¾udKh lrkak'
	

      Wod - ld, igykla" fyd`o jev ,l=Kq lsÍu i`oyd j.=jla wdÈh
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l%shdldrlu 4'1

	 my; oelafjk .eg¨ úYaf,aIKh lr wdodk" l%shdj,sh yd m%;sodk fjkA 

lr olajkak' 

w&	 jhi wjqreÿ 18 fyda Bg jeä kï zzPkaoh m%ldY l< yels h'ZZ 18g wvq 

kï zzPkaoh m%ldY l< fkdyels h'ZZ

wd&	lKavdhï folla w;r mj;sk tlaÈk l%slÜ ;r`.hlska l=uk fyda 

lKavdhula ch ,eîu fyda ch mrdcfhka f;drj wjikaùu

l%shdldrlu 4'2

	 by; 4'1 ^w& u.ska úYaf,aIKh l< .eg¨j i`oyd my; § we;s .e,Sï 

igyfka ;SrK fldgqjg wod< a yd b u.ska olajd we;s ysia;eka iïmQ¾K 

lrkak' 

wdrïNh

ksudj

'''''''' 

'''''''

jhi 18 g 

wvq o@

jhi wdodkh lrkak

zzPkaoh m%ldY l< yels hZZ

zzPkaoh m%ldY l< fkdyels hZZ

a

b

l%uf,aL f.dvke.Su4
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by; .e,Sï igyk wkqj my; m%ldY i,lkak' 

A - wkql%uh muKla iys; h

B - f;aÍu muKla iys; h

C - wkql%uh yd f;aÍu iys; h 

by; m%ldY wkqj"

1).  A muKla i;H fõ    2). B muKla i;H fõ     3). C muKla i;H fõ

4).  lsisjla i;H fkdfõ

l%shdldrlu 4'3

	 by; 4'1 ^wd& u.ska úYaf,aIKh l< .eg¨j i`oyd my; § we;s .e,Sï 

igyfka x yd y u.ska olajd we;s ysia;eka iïmQ¾K lrkak' 

wdrïNh

ksudj

Tõ

ke;

ke;

Tõ

A_ ,l=Kq >B_ 
,l=Kq fõ o@

A_ ,l=Kq <B_ 
,l=Kq fõ o@

lKavdhï fol ,nd we;s ,l=Kq A_ ,l=Kq yd B _ ,l=Kq 

f,i ,nd .kak

zzch mrdcfhka f;drj wjika fõ'ZZ

zz''''''''''' ch.kSZZ

zz''''''''''' ch.kSZZ
x

y
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by; .e,Sï igyk l%shd;aul ùfï§ wdodk ixLHdj yd m%;sodk ixLHdj 

ms<sfj<ska oelafjkafka 

    1).  2, 1 	           2).  3, 1 		     3).  1, 3 	          4).  3, 2

l%shdldrlu 4'4

my; oelafjk Scratch m%ldYj, wjika m%;sM,h fidhkak' A hkq úp,Hhls' 

.................

.................

.................

l%shdldrlu 4'5

my; oelafjk m%ldYj, wjika m%;sM,h ks.ukh lrkak' A hkq 4'4 u.ska 

oelajQ úp,Hh jk w;r tys w.h 15 nj Wml,amkh lrkak' 

i;H $ wi;H

i;H $ wi;H

i;H $ wi;H

i;H $ wi;H
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l%shdldrlu 4'6

^w& by; 4'2 ys we`o we;s .e,Sï igyka i`oyd Scratch l%uf,aLh ks¾udKh 

    lrkak' 

^wd&	 by; 4'3 yd § we;s .e,Sï igyfkys we;s ysia;eka mqrjd Scratch 
  l%uf,aLh ks¾udKh lrkak

l%shdldrlu 4'7

my; .e,Sï igyfkys a, b, c yd d u.ska olajd we;s ysia;eka mqrjkak' fuys§ 

È. iy m<, hk w.hka ÿkaúg" th iup;=ri%hla o RcqfldaKdi%hla o hkak 

;SrKh lrhs' 

wdrïNh

(d) .......

È. yd    ''''''' wdodkh lrkak'(a)

(b)...... (c)......
È. yd m<, 

iudk fõ o@

zziup;=ri%hlaZZ nj 

fmkajkak'

zzRcqfldaKdi%hlaZZ 

nj fmkajkak'

ysia;eka msrùu i`oyd iqÿiq mo ,ehsia;=j ^ksudj" m<," ke;" Tõ&
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l%shdldrlu 4'8

my; .e,Sï igyfkys we;s ysia;eka mqrjkak' fuys § iudk fkdjk ixLHd 

folla wdodkh l< úg bka úYd, ixLHdj l=ulaoehs m%;sodkh lrkak'

ksudj

iudk fkdjk ixLHd fol (A, B) we;=<;a lrkak

ke; Tõ
A < B ?

wdrïNh

'''''''''' úYd, nj 

fmkajkak'
''''''''''' úYd, nj 

fmkajkak'

l%shdldrlu 4'9

1

2

3

mka;sfha kdu f,aLkh ,l=Kq lrk úg isiqjd 

meñK isàkï 1 f,i o meñK ke;s kï 0 

f,i o igyka lrkq ,efí' Bg wod< Scratch 
l%uf,aLh wkqms<sfj<lska f;drj olajd we;' 

ksjerÈ wkqms<sfj<g fm<.iajkak' 

A, B yd C hk ia:dkj,g wod< Wmfoia 

ldKavfha wxlh i`oyka lrkak' 

A =
B =
C =

l%shdldrlu 4'10

    fm<fmdf;ys olajd we;s tla tla cx.u yd iqyqre Wmdx.h yd tys fhÿï 

;j ÿrg;a ,ehsia;= .; lrkak'
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l%shdldrlu 5'1

my; oelafjk mßm:j," ,nd § we;s wdodkj,g wod< m%;sodk ,shd olajkak'

	 1'  

1

0
 

	 2'  

0
1

 

   

	 3'   
1

1

0

oajdrj, l%shdldÍ;ajh uDÿldx. u.ska y`ÿkd .ekSu 

	 Tn fuhg fmr wjfndaO lr.;a ;d¾lsl oajdrj, l%shdldÍ;ajh uDÿldx. 

u.ska y`ÿkd .ekSug yels w;r ta i`oyd MM Logic uDÿldx.h fuys § Ndú; lrkq 

,efí' 

MultiMedia Logic uDÿldx.h 

	 fuu uDÿldx.h wka;¾cd,h Tiafia fkdñf,a nd.; (Download) lr .; 

yels w;r" tys wdrïNl uqyqK; my; mßÈ fõ' 

	 fN!;sl wd.Kkh i`oyd uDÿldx. 
				     Ndú;h	5
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Menu Bar

Toggle Palette Window

Tool Bar

Toggle Palette

Selector

AND Gate

NOT Gate

Switch

Buzzer

Wire

Node

OR Gate

LED

Text
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	 Toggle Palette tl Tool Bar tflys  ixfla;h u; Click lsÍfuka ,nd 

.; yel'

MM Logic uDÿldx.h Ndú; lsÍu

	 Toggle Palette tlska LED n,anhla iy Switch tlla f.k ir, mßm:hla 

f.dvke.Su

LED tl Window tl u;g f.k tau 

Switch tl Window tl u;g f.k tau

Switch tl yd LED tl Wire Ndú; lr 

iïnkaO lsÍu

Tool Bar tflys olakg ,efnk Run u; 
Switch lsÍfuka my; oelafjk mßÈ switch 
j, wdodk fjkia l< yel'

Switch    tl 0 wjia:dfõ § n,anh fkdoe,afõ'

Switch tl 1 wjia:dfõ § n,anh oe,afõ'

Run
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MM Logic uDÿldx.h Ndú; lr uQ,sl ;d¾lsl oajdrj, l%shdldÍ;ajh 

mßlaId lsÍu

NOT oajdrh
 

mßm:h by; ilia lr Run l< úg my; mßÈ tys m%;sodkh ksÍlaIKh l< yel'

SWITCH tflka 1 tkï úÿ,sh ,nd ÿka úg LED n,anh fkdoe,afõ'

SWITCH tflka 0 tkï úÿ,sh ,nd fkdÿka úg LED n,anh oe,afõ' 

l%shdldrlu 5'2

MM logic uDÿldx.h Ndú; lr NOT oajdrh l%shd;aul lsÍfï § fjkia jk 

wdodk" m%;sodk j.=.; lrkak'

wdodk m%;sodk
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AND oajdrh

	 mßm:h by; f,i ilia lr Run l< úg my; mßÈ tys m%;sodkh ksÍlaIKh 

l< yel' 

Switch foflka u 0 ksoyia lrk úg n,anh fkdoe,afõ'

A iaúpfhka 1 yd B iaúpfhka 0 ksoyia lrk úg n,anh fkdoe,afõ'
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A iaúpfhka 0 yd B iaúpfhka 1 ksoyia lrk úg n,anh fkdoe,afõ'

Switch foflka u 1 ksoyia lrk úg n,anh oe,afõ'

l%shdldrlu 5'3

MM logic uDÿldx.h Ndú; lr AND oajdrh l%shd;aul lsÍfï § fjkia jk 

wdodk" m%;sodk j.=.; lrkak'

wdodk A wdodk B m%;sodk
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OR oajdrh

	 mßm:h by; f,i ilia lr Run l< úg my; mßÈ tys m%;sodkh ksÍlaIKh 

l< yel'

Switch foflka u 0 ksoyia lrk úg n,anh fkdoe,afõ'

A iaúpfhka 1 yd B iaúpfhka 0 ksoyia lrk úg n,anh oe,afõ'
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A iaúpfhka 0 yd B iaúpfhka 1 ksoyia lrk úg n,anh oe,afõ'

Switch foflka u 1 ksoyia lrk úg n,anh oe,afõ' 

l%shdldrlu 5'4

MM logic uDÿldx.h Ndú; lr OR oajdrh l%shd;aul lsÍfï § fjkia jk 

wdodk" m%;sodk j.=.; lrkak'

wdodk  A wdodk B m%;sodk
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oajdr ixfhdackfhka iEfok mßm:j, m%;sodk MM Logic uDÿldx.h 

Ndú; lr ,nd .ekSu 

my; oelafjk mßm:h uDÿldx.h Ndú; lr ksrEmKh lsÍu

fuh uDÿldx.h ;=< ksrEmKh l< úg my; mßÈ fõ'

fuh Run lr" fuys wdodk fjkia lrk úg m%;sodkh fjkia ùï my; j.=j 

wdldrfha fõ' ̂ fuys n,anh oe,aùu 1 f,i o" n,anh fkdoe,aùu 0 f,i o ksrEmKh 

lr we;'& 

A B C m%;sodkh 

0 0 0 1
0 0 1 0
0 1 0 0
0 1 1 0
1 0 0 0
1 0 1 0
1 1 0 0
1 1 1 0
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l%shdldrlu 5'5

my; oelafjk mßm: MM Logic uDÿldx.h Ndú; lr ksrEmKh lr wdodk" 

m%;sodk j.=.; lrkak'

1.       	     	 2.  

3.      		  4. 

wdodk A wdodk B m%;sodk

j.=j 1

wdodk A wdodk B wdodk C m%;sodk

j.=j 2

wdodk A wdodk B wdodk C m%;sodk

j.=j 3

wdodk 
A

wdodk 
B

wdodk 
C

wdodk 
D

m%;sodk

j.=j 4
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l%shdldrlu 6'1

wka;¾cd,hg msúi Tnf.a mdvug wjYH f;dr;=re /ia lruq

²² mß.Klhla fyda cx.u ÿrl:khla  

	 fyda Ndú; lrkak' 

²² wka;¾cd,hg msúiSu i`oyd wka;¾cd, 

iïnkaO;d imhk wdh;khla (Internet 
Service Provider-ISP) u.ska Tfí 

WmlrKhg wka;¾cd, myiqlï ,ndf.k 

;sìh hq;=hs' 

²² fjí w;sßlaiq (Internet Browser)  
uDÿldx.hla Tnf.a WmlrKfha ia:dmkh 

lr ;sìh hq;=hs' 

²² th újD; lsÍfuka Tng wka;¾cd,hg iïnkaO úh yels h' 

fjí w;sßlaiq (Internet Browser) uDÿldx. hkq fudkjd o@

²² fjí w;sßlaiqj Tn ^tkï" mßYS,lhd - 

User& iy wka;¾cd,h w;r iïnkaO;dj 

we;s lrhs' 

²² m%Odk fjí w;sßlaiq lsysmhla fuys 

olajd we;' óg wu;rj fjk;a fndfyda 

fjí w;sßlaiq we;' 

wka;¾cd,fha ießiruq6
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wka;¾cd,h Ndú;fhka f;dr;=re .fõIKh 

wka;¾cd, Ndú;fha § wjYH f;dr;=re fidhd .ekSu i`oyd fijqï hka;%hla 
(Search engine) Ndú; l< hq;= fõ' m%Odk fijqï hka;% lsysmhla my; oelafõ' 

óg wu;rj fjk;a fndfyda fijqï hka;% we;'

1'	 fjí w;sßlaiqjla u.ska wka;¾cd,hg msúiqKq Tng újD; jk fjí msgqj 

fufia oelsh yels h' tu fjí msgqj Tn Ndú; lrk fjí w;sßlaiqjg 

wkqj fjkia fõ' 

2'	 Tng wjYH f;dr;=frys uq,a jpkh h;=re,shkh lrkak' túg tu uq,a 

jpkfhka mgka .kakd fjk;a f;dr;=re yd iïnkaO ud;Dld ,ehsia;=jla 

Tng oel .; yels fõ' ta ;=<ska Tng wjYH f;dr;=frys ud;Dldj f;dard 

.kak'

 

fuys h;=re,shkh lrkak
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3'	 Tng wjYH f,i Tnf.a fiùu fjkia lr .kak' ta i`oyd fuu fukq 

;Srej Tng WmldÍ fõ'

ish¨ u f;dr;=re ùäfhda fiùu 

i`oyd

is;shï ,nd.ekSu 

i`oyd

mska;+r fiùu 

i`oyd

m%jD;a;s fiùu 

i`oyd

l%shdldrlu 6'2

wOHdmkh i`oyd Wmldr jk fjí wvú Ndú;fhka f;dr;=re 

.fõIKh 

	 Tnf.a wOHdmkhg úúOdldrfhka Wmldr lr .; yels fjí wvú 

wka;¾cd,fha we;' ta w;r m%Odk ia:dkhla ysñjkafka wOHdmk wud;HxYfha 

zzB-;lai,djZZ fjí wvúhghs' th Ndú; lsÍu Tnf.a wOHdmkhg uy`.= 

w;aje,la jkq we;' tjeks fjí wvú iy fjí ,smsk lsysmhla my; oelafõ'

ÃÃ B-;lai,dj (e-thaksalawa) http://www.e-thaksalawa.moe.gov.lk/
ÃÃ wOHdmk m%ldYk fomd¾;fïka;=j (Educational Publications 

Department) http://www.edupub.gov.lk/
ÃÃ wOHdmk wud;HdxYh (Ministry of Education) http://www.moe.gov.lk/

sinhala/

by; i`oyka fjí wvú fj; lKavdhula f,i msúi tys § ,nd .;a f;dr;=re 

,ehsia;= .; lrkak' 

tl;= lr .;a f;dr;=re wfkl=;a lKavdhï iu. yqjudre lr .kak'
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l%shdldrlu 6'3

fjí msgqjla ks¾udKh lsÍu 

²² ks¾udKhg wjYH uDÿldx.h y`ÿkd .kak' 

²² fjí msgqj i`oyd mska;+r fhdod .kafka kï ks¾udKhg fmr tajd tla 

f*da,avrhl ;ekam;a lr .kak' ^túg tajd fhdod .ekSug iy fidhd 

.ekSug myiq fõ'&

²² ks¾udKh lrkq ,nk iEu fjí msgqjla u tu f*da,avrfha u ;ekam;a 

lrkak'

Tiny Little Bee Brain

Bees fly from flower to flower, sipping nectar and collecting grains 
of pollen. Bees have a special tongue that sucks up the nectar and 
a crop in their throat for storing it until they get back to the hive, 
where it is turned into honey to use as food.

More about Bees

Notepad Ndú;fhka fjí msgqjla ks¾udKh lruq' 

mshjr 1 -	 Notepad  uDÿldx.h 

		  újD; lr .kak' 

mshjr 2 -	 fjí msgqj wdrïN lsÍu i`oyd tys fuu Wiq,k h;=re,shkh 

		  lrkak'

<html>
	 <head>
		  <title></title>
	 </head>
</html>
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mshjr 3 - 	 fjí msgqjg .e<fmk kduhla ,nd Èh hq;=h' th fï wdldrhg 

		  <title></title> Wiq,kh w;rg h;=re,shkh lrkak' (Bees)

<html>
	 <head>
		  <title>Bees</title>
	 </head>
</html>

mshjr 4 - 	 f.dkqj ;ekam;a lrkak'

File → Save → fjí msgqjg wod< mska;+r ;ekam;a lr we;s f*da,avrh újD; 

lr File name → Bees.html hkqfjka h;=re,shkh lrkak'

ie'hq - fjí msgqjla ;ekam;a lsÍfï § iEu úg u 

f.dkq kduh iu. .html hkqfjka f.dkq È.=j 

fhÈh hq;= h' 

f.dkqfõ ku 

Bees.html

f.dkq È.=j

mshjr 5 -	 Tn úiska ilia lrk ,o f*da,avrh újD; lr Bees.html  
		  f.dkqj u; uQislh la,sla lrñka th újD; lr .kak' Tn 

		  Ndú; lrk fjí w;sßlaiqj ;=< th újD; jk w;r fjí 

		  msgqfõ kduh fufia oelsh yels h'

 

mshjr 6 -	 fjí msgqjg ud;Dldjla tl;= lsÍu 

rEmfha oelafjk mßÈ <body></body> Wiq,kh tl;= lr ud;Dldj 

fhdokak' Tiny Little Bee Brain.
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<html>
	 <head>
		  <title>Bees</title>
	 </head>
	 <body>
	 <h1> Tiny Little Bee Brain </h1>
	 </body>

</html>

mshjr 7 -	 fuh ud;Dldjla neúka 

		  th <h1></h1> Wiq,kh  

		  w;rg fhÈh hq;= h'

 

<h1>Heading 1</h1>
<h2>Heading 2</h2>
<h3>Heading 3</h3>
<h4>Heading 4</h4>
<h5>Heading 5</h5>
<h6>Heading 6</h6>

 

W;aidy lr n,kak'

mshjr 8 - 	 ud;Dldj msgqfjys uOHhg .; hq;=hs' ta i`oyd <center></ 
		  center> Wiq,kh fuf,i fhdokak'

<html>
	 <head>
		  <title>Bees</title>
	 </head>
<body>
		  <h1><center> Tiny Little Bee Brain</center> </h1>
</body>

</html>
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mshjr 9 - 	 ks¾udKh kej;;a ;ekam;a lrkak' f.dkqjg f.dia újD; 

		  lr n,kak' 

iEu fjkia lsÍula wjidkfha § f.dkqj ;ekam;a lr fjí w;sßlaiqfõ th 

újD; lr ne,Sfuka Tn fhdod we;s Wiq,k iy fjkiaùï ms<sn`o wjfndaOhla 

,efnkq we;'

mshjr 10 - 	 fjí msgqjg mska;+rhla tla lsÍu 
 

<img src> Wiq,kh w;rg mska;+rfha ku iy 

tys f.dkq È.=j File Extension tl;= l< hq;= 

h' tl u f*da,avrfha we;s mska;+r tl;= lsÍu 

myiq h'

mska;+rfha ku 

Bee1.png
f.dkq È.=j

mshjr 11 - 	 fhdod .kq ,nk mska;+rfha m%udKh úYd, jQ úg fufia  

		  Èiafjk w;r th yiqrejd .; hq;= h'

ta i`oyd mska;+rfha Wi iy m<, md,kh lsÍug Wiq,kh ;=<g Wi iy 

m<, m%udK m%;sY;hla f,i 25%, 50%, 15% we;=<;a lr we;' fuys § Wi 

iy m<, oelaùu i`oyd height iy width keue;s .=Kdx. Attributes fhdod 

.efka'

.=Kdx. (attributes) lsysmhla

Colour j¾K

Align tfl,a, lsÍu

Href wê iïnkaO;dj

src mska;+r 

title ud;Dldj

width m<,

height Wi
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<html>
	 <head>
		  <title>Bees</title>
	 </head>
<body>
		  <h1><center> Tiny Little Bee Brain</center> </h1>
		  <center><img src="1bee.png" height=25%, 
width=25%></center>
</body>

</html>

mshjr 12 -	 mska;+rh msgqfjys uOHhg  

		  .; hq;=hs' ta i`oyd <center></ 
		  center> Wiq,kh fhdokak'

mshjr 13 - 	 fjí msgqjg fþohla tl;= lsÍu' 

ta i`oyd <p></p> Wiq,kh tla lr ta w;rg my; 

oelafjk fþoh h;=re,shkh lrkak' 

Bees fly from flower to flower, sipping nectar and collecting grains of 
pollen. Bees have a special tongue that sucks up the nectar and a crop in 
their throat for storing it until they get back to the hive, where it is turned 
into honey to use as food.

<html>
	 <head>
		  <title>Bees</title>
	 </head>
<body>
		  <h1><center> Tiny Little Bee Brain</center> </h1>
		  <center><img src="1bee.png" height=25%, 
width=25%></center>
		  <p> Bees fly from flower to flower, sipping nectar and 
collecting grains of pollen. Bees have a special tongue that sucks up the 
nectar and a crop in their throat for storing it until they get back to the 
hive, where it is turned into honey to use as food.
		  </p>
</body>
</html>
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Tiny Little Bee Brain

Bees fly from flower to flower, sipping nectar and collecting grains of 
pollen. Bees have a special tongue that sucks up the nectar and a crop 
in their throat for storing it until they get back to the hive, where it is 
turned into honey to use as food.

mshjr 14 - 	 fþofha wl=re yeviõ lr .ekSu i`oyd <h3></h3> Wiq,kh 

		  <p></p> Wiq,kh w;rg fhdokak'

<p><h3>Bees fly from flower to flower, sipping nectar and collecting 
grains of pollen. Bees have a special tongue that sucks up the nectar 
and a crop in their throat for storing it until they get back to the hive, 
where it is turned into honey to use as food.
</h3></p>  

  

Tiny Little Bee Brain

Bees fly from flower to flower, sipping nectar and collecting grains of pollen. 
Bees have a special tongue that sucks up the nectar and a crop in their throat 
for storing it unit they get back to the hive, where it is turned into honey to 
use as food.

mshjr 15 - 	 wjidk jdlH tl;= lsÍu' 

my; oelafjk wdldrhg h;=re,shkh lrkak' tys yev wl=re fh§u i`oyd 

<i></i> Wiq,kh o wl=re m%udK lsÍu i`oyd <h4></h4> Wiq,kh  o fhdod 

we;'

More about Bees <h4><i>More about Bees</i></h4>
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mshjr 16 - 	 fjí msgqjg fhdod we;s wl=re j¾K .ekaùu

fï i`oyd fhdod .kq ,nkafka <font></font> Wiq,khhs' wl=re j¾K .ekaùu 

i`oyd Color keue;s .=Kdx.h (Attribute) fhdod f.k we;' my;ska olajd 

we;s WodyrKfhA wdldrhg wjYH ia:dk i`oyd j¾K tl;= lrkak'

<h1><center> <font color="Navy">Tiny Little Bee Brain </font> </
center></h1>
<center><img src="1bee.png" height=25%, width=25%></center>
<p><h3><font color="green">Bees fly from flower to flower, sipping 
nectar and collecting grains of pollen. Bees have a special tongue that 
sucks up the nectar and a crop in their throat for storing it until they get 
back to the hive, where it is turned into honey to use as food.
</font></h3></p>
		
<h4><i><font color="red">More about Bees</font></i></h4>

l%shdldrlu 6'4

Interesting Facts about Tiny Bee

²	 Bees have 5 eyes and 6 legs.
²	 Honey bees harvest nectar and pollen from flowering plants. 
²	 A single bee can collect enough nectar to make 1/12 of a teaspoon 

of honey.
²	 Honey has Surprising Health Benefits. 
²	 Honey bees are super-important pollinators for flowers, fruits and 

vegetables.
²	 Honey bees live in large groups called colonies.
²	 An average beehive can hold around 50,000 bees. 
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by; rEmfha oelafjk wdldrhg kj fjí msgqjla ks¾udKh lruq'

mshjr 1 - 	 tys fhdod f.k we;s wdldrhg 

a.  msgq kduh (Bee Facts) 
b.  ud;Dldj (Interesting Facts about Tiny Bee)
c.  mska;+r 

tl;= lr fï jk úg Tn bf.k .;a Wiq,k Ndú; lr my; oelafjk 

WodyrKh o WmldÍ lrf.k fjí msgqfõ uq,a fldgi ks¾udKh lr Tnf.a 

f*da,avrfha BeeFacts.html kñka ;ekam;a lrkak'

<html>
       <head>
	 <title>BeeFacts</title>
      </head>
	 <body>
	      <center><p><h2><i><font color="red">Interesting Facts 
about Tiny Bee </font> </i></h2></p>
		  <img src="honey.png" height=25%, width=15%><img 
src="flower.png"></center>
                </body>
</html>

mshjr 2 - 	 fjí msgqjg ,ehsia;=jla tl;= lsÍu

fuh nq,Ü ,ehsia;=jla neúka th <ul></ul> Wiq,kh ;=< h;=re,shkh l< 

hq;= h' fma<sfhka fma<shg fjka lsÍu i`oyd ta ;=< <li></li> Wiq,k fhdod 

.kq ,efí' fuu fma<s tlsfkl fjka fjka jYfhka" 

   ²	 <font color></font> Wiq,kh Ndú; lr j¾K .kajd we;' 

   ²	 <i></i> Wiq,kh Ndú; lr we, wl=re njg m;a lr we;' 

   ²	 <h3></h3> Wiq,kh Ndú; lrñka m%udK lr we;' 

<h3></h3> Wiq,kh iy <center></center> Wiq,kh Ndú; lr ,ehsia;=fjka 

msg; wjidk jdlHh Back to Home ilia lr we;'
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²² Bees have 5 eyes and 6 legs
²² Honey bees harvest nectar and pollen from flowering plants	
²² A single bee can collect enough nectar to make 1/12 of a teaspoon 

of honey
²² Honey has Surprising Health Benefits
²² Honey bees are super-important pollinators for flowers, fruits and 

vegetables
²² Honey bees live in large groups called colonies
²² An average beehive can hold around 50,000 bees

<html>
       <head>
	 <title>BeeFacts</title>
      </head>
	 <body>
	      <center><p><h2><i><font color="red">Interesting Facts about 
Tiny Bee</font></i></h2></p>
<img src="honey.png" height=25%, width=15%><img src="flower.png"> </
center>
<ul>
	   <li><h3><i><font color="blue">Bees have 5 eyes and 6 legs.</i> 
</h3></li>
<li><h3><i><font color="green">Honey bees harvest nectar and pollen from 
flowering plants.</i></h3></li>
<li><h3><i><font color="orange">A single bee can collect enough nectar to 
make 1/12 of a teaspoon of honey.</i></h3></li>
<li><h3><i><font color="red">Honey has Surprising Health Benefits </i> </
h3></li>
<li><h3><i><font color="blue">Honey bees are super-important pollinators 
for flowers, fruits and vegetables.</i></h3></li>
<li><h3><i><font color="green">Honey bees live in large groups called 
colonies.</i></h3></li>
<li><h3><i><font color="orange">An average beehive can hold around 
50,000 bees.</i></h3></li>
</ul>
	     <h4><center>Back to Home</center></h4></a>
 </body>
</html>

mshjr 3 - 	 ilia lr .;a ks¾udKh ;ekam;a lrkak'
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l%shdldrlu 6'5

fjí msgq w;r wê iïnkaO;d fh§u 

ilia lr .;a fjí msgq fol wê iïnkaO;d fhdod tlsfkl iïnkaO l< 

yels h' 

mshjr 1 -	 ;ekam;a lr .;a fjí msgq fol y`ÿkd .kak'

i.	 Bees.html
ii.	 BeeFacts.html

fjí msgq foflys u wjidkhg we;s jdlH wê iïnkaO;dj we;s lsÍu i`oyd 

fhdod .ksuq'

Bees.html - More about Bees

BeeFacts.html - Back to Home  

 

mshjr 2 - 	 Notepad uDÿldx.h újD; lr fuu f.dkq fol fjka fjka  

		  jYfhka újD; lr .kak' my; oelafjk wdldrhg wjidk  

		  jdlHhg <a href> </a> Wiq,kh u.ska wê iïnkaO;d  

		  fhdod we;s wdldrh wOHhkh lrkak' 

tl u f*da,avrhl we;s f.dkq i`oyd wê iïnkaO;d fh§u myiq jk neúka 

fjí msgqjla ks¾udKfha § wjYH ish¨ u f.dkq" mska;+r" ùäfhda wdÈh tl u 

f*da,avrhlg tl;= lsÍu jeo.;a h'

Bees.html

<a href="Bees.html"><h4><center>Back to Home</center></h4></a>

BeeFacts.html

<a href="BeeFacts.html"><h4><i><font color="red">More about 
Bees </font> </i></h4></a>

mshjr 3 - 	 f.dkq ;ekam;a lr .kak' 

mshjr 4 - 	 fjí w;sßlaiqfõ újD; lr .kak'
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l%shdldrlu 6'6

1'	 óueiaika ms<sn`oj fjk;a f;dr;=re fidhkak' (Types of Bees, Use of 
Honey to be Healthy, How to Protect Bees) tajd i`oyd fjka fjka 

jYfhka fjí msgq ks¾udKh lrkak' 

2'	 wê iïnkaO;d u.ska tajd tlsfkl iïnkaO lrkak'

l%shdldrlu 6'7

Beautiful Waterfalls in Sri Lanka

The country is home to more than 100 waterfalls and rivers which 
at the end stop at the Indian Ocean. Some of the waterfalls are  
man-made but still don't stop short of being breath-takingly 
beautiful

•	 Baker's Waterfall
•	 Bambarakanda Ella
•	 Bopath Ella
•	 Devon Waterfall
•	 Diyaluma Waterfall
•	 Dunhinda Waterfall

More about waterfalls
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by;ska olajd we;s fjí msgqj ks¾udKfha § fhdod f.k we;s Wiq,k wvx.= 

f,aLkh my;ska olajd we;' tys we;s ysia;eka mqrjd f,aLkh iïmQ¾K lrkak'

<html>
……………..
………………Waterfalls</title>
</head>
<body>
<h1>……………...<font color="Navy"> Beautiful Waterfalls in Sri Lanka </
font> </center> </h2> 
<center><……………….="waterfall.png" ></center>
<p><h2><……………………….="green"><center>The country is home to 
more than 100 waterfalls and rivers which stop at the Indian Ocean. Some of 
the waterfalls are man-made but still don't stop short of being breath-takingly 
beautiful.</center></font>……………...<p>
……………<h2>
	 <li><i>Baker's Waterfall </i></li>
	 ……<i>Bambarakanda Ella</i></li>
	 <li><i>Bopath Ella</i></li>
	 <li><i>Devon Waterfall</i>…………
	 <li><i>Diyaluma Waterfall</i></li>
	 <li>………….Dunhinda Waterfall</i></li>
</h2></ul>		
<……………………="morefalls.html"><i><center>More about waterfalls 
…………………..<i></a>
………………………
……………………..


